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PRODUCT REVIEW 

LibreOffice Draw – A PDF Editor in Disguise 

I 
n a recent article (PDF File Editor – Plus!), I discussed using Sejda PDF Editor to 
modify a PDF file noting that this program has a number of limitations on its use.  
Now, while the program was adequate for my meagre needs at the time, I decided 

to seek out a more robust solution for possible future use. 

Interestingly, whereas I can normally find freeware and/or open-source software to 
replicate the tasks performed by any proprietary package, initially this didn’t seem 
to be the case for PDF editors.  Almost all of the programs that I identified had sig-
nificant limitations on their use, were purely web-based, or turned out to be limited-
time trial versions.  Then I came across a possible solution that was already installed 
on my system – LibreOffice Draw. 

I have used LibreOffice Writer and Calc extensively, on both Linux and Windows 
platforms, for many years.  I have also used Impress for some specific purposes, and 
have dabbled minimally with Base, but have done very little exploration of the 
suite’s other modules, Draw and Math.  So, it came as a pleasant surprise when I 
found on-line reviews showcasing Draw as a free PDF editor. 

My testing of Draw was largely based on the tasks that I previously needed to per-
form in editing an existing PDF file, namely: adding text to data fields, adding form 
elements (data entry fields), removing (hiding) the entry to a checked box, and add-
ing a signature to a pre-defined data field. Three of these functions are demonstrated 
in the following screenshot where the name and date fields have been updated, the 
“Yes, I agree” checkbox has been blanked, and a signature is in the process of being 
added to the document.  

Given that Draw is actually a drawing module for the office suite, one might expect 
that a number of additional tools, providing the ability to include objects such as 
lines, shapes, and symbols in a document would also be available and indeed this is 

the case even when editing a PDF file.  
A wide range of such tools is available 
in a sidebar, or through the icons and 
menu items in the program’s ribbon 
interface. 

The ability to open PDF files, together 
with the multiplicity of available draw-
ing tools, make Draw a powerful yet 
intuitive PDF editor.  Many users may 
already have this package in their 
toolbox since they have the full Li-
breOffice suite installed.  If not, the 
program is free and is readily available 
for downloading and installation on 
both Windows and Linux systems. 

 

Bottom Line: 

LibreOffice (Open source) 
Version 7.3.3 
The Document Foundation 
https://www.libreoffice.org 

 

by Alan German 
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2022 CALENDAR 

Meetings Date Time and Venue 

Regular Monthly Meeting Wednesday, November 9th 
7:30 pm via Zoom video conference: https://tinyurl.com/opcug-meeting 
To see all scheduled events, visit https://opcug.ca/#upcoming 

Next Q&A Session Wednesday, October 26th 
Until further notice, Q&A sessions are no longer held after regular 
monthly meetings. Join us on all other Wednesdays for weekly Q&A. 

Beer BOF (Wing SIG East) Wednesday, November 9th 
Enjoy a cold brew or other beverage in the comfort of your home during 
the video conference. 

 

Next Meeting 
 

Wednesday, November 9, 2022 

WINDOWS 11, IT’S HERE TO STAY 

Speaker: Lawrence Patterson, OPCUG 

Oh Microsoft, with 75%+ of computer users running your 
operating system, you would think that people would be 
clamouring for Windows 11, yet with ~3 years of support 
life left in Windows 10, most are not bothered thinking 
about it and heh, Windows 12 is just right around the cor-
ner, right? 

Understanding that using tech is riding a wave, we’re go-
ing to delve into Windows 11 as it stands with its lat-
est 22H2 – sorry those darn Microsoft marketing folks 
can’t stop tinkering – 2022 update and the features it of-
fers to us ordinary Home / Pro users (yes Enterprise users 
have better protection, at a price mind you). 

Come as we explore Windows 11’s inner workings and 
how at least some of us might actually like where Mi-
crosoft is taking us (all grumbling to the side). 

This meeting will be via Zoom video conference. 

Join us at https://tinyurl.com/opcug-meeting. The Zoom 
link will be live at 7:15 pm. The meeting will begin at 
7:30 pm. 

The above link includes the meeting ID and password. 
However, if you are prompted for the information, use: 
Meeting ID: 924 9556 0898 
Password: opcug 

Coming Up… 
 

October 26 

Weekly Q&A Session 

 

November 2 

Weekly Q&A Session 

 

December 14 

Transmission Control Protocol/Internet Protocol (TCP/
IP) Overview 
Speaker: Stéphane Richard 

All scheduled regular monthly meetings, weekly Q&A sessions, and a link to OPCUG presentations at the OPL are 
posted on our website at https://opcug.ca/#upcoming. All events are via video conference until further notice. 

2https:/opcug.ca/events/qa-weekly-session/
https://opcug.ca/qa/
https://opcug.ca/events/windows-11-its-here-to-stay/
https://tinyurl.com/opcug-meeting
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/events/tcp-ip-overview/
https://opcug.ca/events/tcp-ip-overview/
http://opcug.ca/#upcoming
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/opl-presentations/
https://opcug.ca/events/qa-weekly-session/
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ARTICLE 

BrowsingHistoryView 

I 
n most browsers, you can access your browsing his-
tory by pressing Ctrl-H. But if you want to save a 
list of your history, not even Quick Tip 41 will help. 

Fortunately, BrowsingHistoryView, a free program 
from Nirsoft, will do the trick. It can capture the history 
from 14 different browsers including all the main ones: 
Firefox, Chrome, Edge, Opera, Brave, Vivaldi, and 
Internet Explorer. 

Download the utility from https://www.nirsoft.net/utils/
browsing_history_view.html. It requires no installation; 
unzip the file anywhere that is convenient and run 
BrowsingHistoryView.exe 

By default, when you load the program, Advanced Op-
tions opens, where you can choose the major behav-
iours of the program. You can access Advanced Op-
tions at any time from the Options menu. 

 

The main options are; 

 Filter by visit date/time: useful if you are look-

ing for history items from a particular 
timeframe. 

 Include or exclude URLs that contain a given 

string. 

 Load the history for all users on the computer or 

even another computer across the network 

(administrator rights are required). 

By default, BrowsingHistoryView loads the history from the past 10 
days, for all users on the local computer, for all supported browsers. 

Once the complete list loads—on my desktop computer over 30,000 
lines loaded when I chose Load history items from any time—you can 
sort by clicking on any column header. Click a second time to reverse 
the sort. Drag and drop the headers if you want them in a different 
order. You can remove columns you don’t need from the View menu. 

A Find function on the Edit menu (or F5) allows you to search for text 
that appears in any history record. 

Right-click an entry for a context menu allowing various functions 
such as seeing the full properties of the history item, loading the web 
page in your browser, and more. 

 

What drew me to BrowserHistoryView is the ability to export the 
complete history list. Select all records by pressing Ctrl-A and choose 
File | Save Selected Items. The default—Text File—will save each 
record as multiple lines as follows. 

If you want to post-process the results, it is more useful to choose 
Comma Delimited Text File (*.csv) from the Save dialog box. Each 
record will be exported as a single line and the results can then be 
imported into a spreadsheet for further analysis or manipulation. 

One thing BrowsingHistoryView taught me is that I should trim my 
history—I don’t think I actually need my history of browsing from 

over 6 years ago! It is a surprisingly difficult task within browsers to 
delete history older than—say—2 years, often requiring some sort of 

browser extension. But BrowsingHistoryView makes it a breeze—at 
least for Firefox and Chrome (and other Chromium-based browsers). 
Start by closing your browser. In BrowsingHistoryView, select the 

history records you want to delete, choose File | Delete Selected His-
tory Records, and—poof—they are gone! 

 

 

by Chris Taylor 

https://opcug.ca/Articles/2202NEWS.pdf
https://www.nirsoft.net/utils/browsing_history_view.html
https://www.nirsoft.net/utils/browsing_history_view.html
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Focal length compression – what it is and what it isn’t 
by Lynda Buske 
 

W 
hile we often hear that focal length compression is caused by the use of a telephoto lens versus a wide-

angle lens, it is actually only related to the distance you are from the objects of interest. If you are the 

exact same distance from an object and take a photo with both a wide angle and a telephoto lens, there 

will be no compression effect, although you will have to crop the wide angle to have the same framing. See example 

images below.  

 

 
 

 

(continued on next page) 

This article is also in PDF format on the OPCUG website 
(https://opcug.ca/digital-photography/). 

A guide to digital photography for computer enthusiasts. After the click of your camera, you’re only half done! 

THROUGH THE LENS 

Wide angle lens (9.1mm)  Slight zoom (27mm) but taken from same position 

Wide angle cropped to match zoom shot. No compression 

visible 

Taken much further away with a long focal length (60mm). 

The rear silver car appears much larger and closer to the 

black car than in the above photos. This is the compression 

effect. Note also how close the stop sign appears compared 

to wide angle shot where it is too far back to even be in the 

photo! 
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Focal length compression  (continued from previous page) 

 

Schematic of the phenomenon below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nominations for OPCUG Board for 2023 

O nce a year, the OPCUG holds elections for the 9-member Board of Directors. We are once again 
coming up to this annual event. 

We encourage all members to consider running for a board position or getting involved in some other 
manner in the operations of the OPCUG.  

If you want more information about what is involved, please talk to me or any current or past Board 
member. Names are listed on the back page of this newsletter and on the web site at https://opcug.ca/
executives/. 

Nominations can be submitted by sending an email to nominations@opcug.ca . 

Nominations must be received by midnight, December 31, 2022. 

Please get involved.  Please help the OPCUG continue in its role of Users helping users ! 

Bob Herres 
Election Chair, 2023 

https://opcug.ca/executives/
https://opcug.ca/executives/
mailto:nominations@opcug.ca
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This month’s blast is from November 1999. See the next page for Bob’s retrospective and 1999 OPCUG milestones. 

https://opcug.ca/Articles/9911.pdf
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Club History - 1999 (taken from https://opcug.ca/history/) 

Dec 1999 The Pub gets a new backup system on tape and an upgrade of Wildcat and Listserve. The answering ma-
chine is shut down because the meeting information is now available on the web. 

Nov 1999 PUB II is now protected by Black Ice Defender. 

Oct 1999 Terry Mahoney represented the OPCUG group at the Microsoft Developer Days. 

Feb 1999 To help increase membership, the program "Bring a member" is held in March, April, May with the win-
ner announced in June. The member gets one ticket for each guest he brings and 3 more if the guest be-
comes a member. The prizes are Corel Draw 8, Partition Magic and a one-year membership. 

Jan 1999 Swap meet held at the museum. 

I 
n the November 1999 issue of the OPCUG Newsletter (Volume 16, No. 10), there was an article by the 
Canadian Alliance Against Software Theft (CAAST) titled ‘Software Piracy’. Software piracy has been a 
problem since the early days of computers, and continues to be a problem today.  

In the early days of personal computers, you could simply and easily make a copy of most software. As 
software companies started to develop copy protection technology, software pirates developed ways to get 
around it. Software with the copy protection removed was a hot commodity on the early internet. To combat 
this, the software industry formed organizations like CAAST to go after the pirates, and to inform the soft-
ware buying public about the issues surrounding software piracy and how to avoid unknowingly buying pi-
rated software. 

To a certain extent their efforts have been successful, but some of that success may also be due to the com-
peting growth of shareware, freeware, freemium and other low or no cost alternatives to popular commercial 
software like LibreOffice and Linux. You can have your computer loaded with lots of capable non-pirated 
software without spending anything. 

Retrospective: Software Piracy by Bob Walker 

Quick Tip 48: Drag & drop into a program  
by Chris Taylor 

 

Y 
ou are working on a Microsoft Word document and want to insert a picture. You click on Insert | Pictures | 
Insert Picture From - This Device… (3 mouse clicks) and a dialogue box opens. Browse to find the picture you 
want, then click the Insert button.  

There is a faster way. In File Explorer (or your favourite file manager), find the picture you want. Drag it over the 
document you are editing in Word. Drop it. 

Some other examples: drag a photo and drop it on Windows Paint or Photoscape X to edit it; drag an Excel workbook 
and drop it on LibreOffice Calc to open it there; drag a piece of clip art and drop it on a PowerPoint slide to insert it; 
or drag a text file and drop it on Notepad to edit it; drag a file and drop it on an email you are creating to add either as 
an attachment or inline (if it’s an image).. 

If the program window is covered with other windows, drag the file and hover over the program icon on the taskbar. 
The program will pop to the foreground. Keep holding the mouse button down and drag the file over the program 
window and release the mouse button. 

Not all programs support drag and drop, but if yours do, it can help speed things along. 

https://opcug.ca/history/
https://opcug.ca/Articles/9911.pdf
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O T T A W A  P C  N E W S 

Ottawa PC News is the newsletter of the Ottawa PC Users’ Group (OPCUG), and is 
published monthly except in July and August. The opinions expressed in this newsletter may 
not necessarily represent the views of the club or its members.  

Member participation is encouraged. If you would like to contribute an article to Ottawa PC 
News, please submit it to the newsletter editor (contact info below). Deadline for submissions  
is three Sundays before the next General Meeting. 

 

To receive the monthly newsletter by email, send an email to:  
opcug-newsletter+subscribe@googlegroups.com  (leave subject and body fields blank) 
You do not need to create a Gmail or Google Groups account. 

To subscribe to other OPCUG Google Groups member services, go to: 

https://opcug.ca/google-groups-how-to/  

 

Group Meetings 

OPCUG meets on the second Wednesday in the month, except July and August, at 
the Riverside United Church, 3191 Riverside Drive, Ottawa. Parking is free at the 
church. OCTranspo bus #90 stops nearby. Details at https://opcug.ca/venue/. 
(NOTE: Due to COVID-19 safety guidelines, all our events are via video confer-
ence until further notice. Details at https://opcug.ca/venue/) 

Meetings are 7:30–9:00 p.m. followed by a Q&A Session until 10 p.m.  

OPCUG Membership Fees:  $20 per year 
Mailing Address:   3 Thatcher St., Nepean, Ontario, K2G 1S6 
Web address:   https://opcug.ca 
Follow us on Facebook:   https://www.facebook.com/opcug 
Follow us on Twitter:   https://www.twitter.com/opcug 
 

President and System Administrator 
 Chris Taylor       chris.taylor@opcug.ca  613-727-5453 

Meeting Coordinator 
 Lawrence Patterson meetings@opcug.ca 

Treasurer 
 Alan German  alan.german@opcug.ca 

Secretary 
 Gail Eagen       gail.eagen@opcug.ca 
Membership Chairman 
 Mark Cayer      mark.cayer@opcug.ca  613-823-0354 
Newsletter 
 Brigitte Lord   brigittelord@opcug.ca 
 (editor/layout/e-distribution)    
Public Relations 
 Lawrence Patterson PR@opcug.ca   
Facilities 
 Bob Walker       613-489-2084 
Webmaster 
 Brigitte Lord       webmaster3@opcug.ca 
Privacy Director 
 Wayne Houston  privacy2@opcug.ca 
Special Events Coordinator 
 (Mr.) Jocelyn Doire jocelyn.doire@opcug.ca 

Director w/o Portfolio    

 Karen Wallace-Graner karenwg@opcug.ca 

 

© OPCUG 2022.  

Reprint permission is granted* to non-profit organizations, provided credit is given to the author and  
The Ottawa PC News. OPCUG requests a copy of the newsletter in which reprints appear.  

*Permission is granted only for articles written by OPCUG members, and which are not copyrighted by the    
author. Visit https://opcug.ca/copyright-and-usage/. 

Q&A HAS GONE 
ON-LINE! WEEKLY! 

Because of the pandemic, the OPCUG 
is holding weekly Q&A sessions in 
Zoom video-conferences. 

Join us every Wednesday (except on 
regular monthly meeting nights) at 
7:30 pm to discuss computer issues. 
Questions (and answers) on any com-
puter-related issue are welcome.  Or, 
do you have a favourite computer pro-
gram or topic that you would like to 
share with the group?  Send your ques-
tions, answers, or the details of what 
you would like to share to:  
SuggestionBox@opcug.ca 

Everyone is welcome to attend Q&A 
sessions and to ask questions about 
their specific computer-related prob-
lems.  Join us at: https://tinyurl.com/
opcug-meeting (if you use the Zoom 
client, the meeting ID is 924 9556 0898 
and the password is opcug). 

mailto:opcug-newsletter+subscribe@googlegroups.com
https://opcug.ca/google-groups-how-to/
http://riversideunitedottawa.ca/
https://opcug.ca/qa/
https://opcug.ca/qa/
mailto:SuggestionBox@opcug.ca
https://tinyurl.com/opcug-meeting
https://tinyurl.com/opcug-meeting

